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Apparence de LibreOffice

LibreOffice fonctionne sous les systèmes d’exploitation Windows, Linux et Mac OS X, chacun de
ces systèmes pouvant exister sous plusieurs versions. Chacune de ces configurations peut donner
lieu  à  des options  d’affichage différentes  (polices,  couleurs,  thèmes,  gestionnaire  de fenêtres,
icônes). De plus, ces options d’affichage sont pour certaines personnalisables par les utilisateurs.

Les illustrations  de ce chapitre ont  été réalisées sous Windows avec le  jeu  d’icônes  Galaxy.
Certaines  images  ne  ressembleront  donc  pas  exactement  à  ce  que  vous  voyez  sur  votre
ordinateur. En cas de confusion sur une icône, dont l’apparence peut être très différente d’un jeu à
l’autre, vous pouvez vérifier son nom, qui apparaît dans l’infobulle lorsque vous placez le pointeur
de  la  souris  au-dessus.  Pour  modifier  le  style  des  icônes,  sélectionnez  Outils  >  Options  >
LibreOffice > Affichage et dans la section Interface utilisateur choisissez la taille et le style des
icônes.

Introduction

Ce chapitre décrit comment gérer les objets graphiques, en particulier comment les faire pivoter,
les  déformer,  les  arranger  et  les  positionner  sur  la  diapositive.  Bien  que  ce  chapitre  traite
essentiellement  des  formes  pouvant  être  créées  avec  les  outils  d’Impress,  certaines  des
techniques décrites peuvent aussi s’appliquer aux images importées dans les diapositives.

Barre d’outils dessin

Outils de dessin livrés par défaut
La barre d’outils Dessin (Figure 1) est pourvue de la majorité des outils nécessaires pour créer des
objets  graphiques.  Si  cette  barre  d’outils  n’est  pas  affichée,  choisissez  Affichage  >  Barres
d’outils > Dessin dans le menu principal. Le Tableau 1 décrit l’ensemble d’outils fourni par défaut
dans la barre d’outils Dessin.

Figure 1 : Barre d’outils Dessin

Note

Votre barre d’outils Dessin peut différer de celle de la Figure 1, car elle dépend du 
nombre d’outils qui y ont été placés. Cliquez-droit sur la barre, et choisissez Boutons
visibles pour afficher les boutons disponibles. Dans le sous-menu, vous pouvez 
choisir de placer ou non les boutons sur la barre d’outils, l’icône des boutons visibles 
étant entourée d’une bordure. Notez également que certaines icônes de la barre 
d'outils Dessin peuvent changer selon la dernière forme sélectionnée.

Tableau 1 : Jeu d’outils de dessin présents par défaut sur la barre d’outils Dessin.

Outil Nom Effets

Sélectionner Sélectionne des objets. Pour sélectionner un groupe d’objets, cliquez au-
dessus et à gauche de l’objet le plus haut à gauche, puis glissez la 
souris jusqu’au-dessous et à droite de l’objet le plus bas à droite du 
groupe sans relâcher le bouton. Un rectangle délimité par des poignées 
de sélection apparaît englobant les objets sélectionnés. Vous pouvez 
aussi sélectionner plusieurs objets en maintenant la touche Maj appuyée
tout en sélectionnant individuellement les objets.
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Outil Nom Effets

Ligne Trace une ligne droite entre le point où vous cliquez et le point où vous 
avez fait glisser la souris et relâché le bouton. Pressez la touche Maj 
pour forcer l’angle de la ligne à des multiples de 45°. Pressez la touche 
Alt pour tracer une ligne à partir de son centre. La touche Alt permute 
également la capture ou non par la grille (voir “Capturer des objets à la 
grille ou aux lignes de capture”, page 23).

Ligne avec
 

flèche à la fin

Trace une ligne droite se terminant par une flèche. La flèche est placée 
au point où vous relâchez le bouton de la souris. Les touches Maj et Alt 
produisent les mêmes effets que pour l’outil Ligne.

Rectangle Dessine un rectangle dont les angles opposés en diagonale sont le point
où vous cliquez et le point où vous avez fait glisser la souris et relâché le
bouton. Pressez la touche Maj pour tracer un carré. Pressez la touche 
Alt pour tracer un rectangle depuis son centre (en combinaison avec 
Maj, vous obtenez un carré).

Ellipse Dessine une ellipse. Pressez la touche Maj pour tracer un cercle. 
Pressez la touche Alt pour tracer une ellipse depuis son centre (en 
combinaison avec Maj, vous obtenez un cercle).

Texte Crée un cadre de texte dont le contenu est aligné horizontalement.

Texte vertical Crée un cadre de texte dont le contenu est aligné verticalement. Cet outil
n’est disponible que si la prise en charge des langues asiatiques est 
activée dans Outils > Options > Paramètres linguistiques > Langue.

Courbe Trace une courbe selon l’option choisie. L’icône dépend de l’option 
choisie. Cliquez sur le triangle noir pour voir les différentes options. 
Notez que le titre de ce sous-menu, lorsqu’il est détaché de la barre 
d’outils Dessin est intitulé Lignes.

Connecteur Trace une ligne de connexion entre deux figures. L’icône dépend de 
l’option choisie. Cliquez sur le triangle noir pour voir les différentes 
options. Chaque option est décrite dans “Utiliser les connecteurs”, page
26.

Formes de
 

base

Cliquez sur le triangle noir pour ouvrir une barre d’outils affichant les 
formes disponibles. L’icône dépend de la forme choisie. Sélectionnez la 
forme de base choisie, puis tracez-la en cliquant sur la diapositive et en 
faisant glisser la souris pour dessiner le rectangle qui l’englobera. 
Pressez la touche Maj pour tracer une forme de hauteur et largeur 
identiques, sauf pour les formes respectant cette contrainte par définition
(carré, cercle, anneau) et pour lesquelles la touche Maj permet de ne 
plus respecter cette contrainte. Pressez la touche Alt pour tracer une 
forme depuis son centre. Les formes disponibles sont :
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Outil Nom Effets

Formes des 
symboles

Comme pour les formes de base, les symboles disponibles sont :

Flèches 
pleines

Comme pour les formes de base, les flèches disponibles sont :

Organigram-
mes

Comme pour les formes de base, les formes disponibles sont :

Légendes Comme pour les formes de base, les formes de légende disponibles 
sont :

Étoiles Comme pour les formes de base, les étoiles disponibles sont données 
ci-dessous. Notez que le titre de ce sous-menu, lorsqu’il est détaché de 
la barre d’outils Dessin est intitulé Étoiles et bannières.

Points (F8) Édite les points qui constituent une forme ou une ligne. Sélectionnez cet 
outil, puis sélectionnez une forme ou une ligne, vous pouvez alors la 
déformer en déplaçant les points bleus. Pour sélectionner cet outil, vous 
pouvez aussi presser la touche F8.

Points de 
collage

Édite les points de collage d’un objet graphique. Les Points de collage 
sont les points de l’objet où les extrémités des connecteurs peuvent 
s’accrocher automatiquement. Voir “Gestion des points de collage”, page
26, pour information.

Galerie 
Fontwork

Ouvre la galerie Fontwork. Voyez “Utiliser Fontwork”, page 31, pour plus 
d’information.

À partir d’un 
fichier

Équivaut à Insertion > Image > À partir d’un fichier du menu principal.
Voir le Chapitre 4, Ajouter et mettre en forme des images pour plus de 
détails.

Gallery Ouvre Gallery. Équivalent à Outils > Gallery du menu principal. Voir le 
Chapitre 4, Ajouter et mettre en forme des images pour plus de détails.

(Dés)activer 
l’extrusion

Active ou désactive les effets 3D pour l’objet sélectionné. Voyez 
“Travailler avec des formes 3D”, page 28 pour les détails.

Outils de dessin supplémentaires
Vous pouvez afficher des outils supplémentaires sur la barre d’outils Dessin (Figure 1). Ces outils
sont décrits dans le Tableau 2.

Pour ajouter ou retrancher des outils à la barre d’outils Dessin :

1) cliquez-droit sur les icônes de la barre d’outils Dessin, un sous-menu apparaît ;

2) choisissez Boutons Visibles pour afficher la liste des outils disponibles ;
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3) cour affecter un outil, cliquez sur son icône pour le faire apparaître sur la barre d’outils,
et la liste se ferme automatiquement ;

4) pour retirer un outil, cliquez sur son icône pour le faire disparaître de la barre d’outils.
L’icône  des  outils  installés  est  entourée  d’une  bordure.  La  liste  se  ferme
automatiquement.

Tableau 2 : Outils de dessin supplémentaires

Outil Nom Effets
Lignes et  
flèches

Dessine une ligne se terminant par une flèche. L’icône dépend de l’option
choisie. Cliquez sur le triangle noir pour voir les différentes options. Les 
touches Maj et Alt produisent les mêmes effets que pour l’outil Ligne.

Objets 3D Cliquez sur le triangle noir pour ouvrir une barre d’outils affichant les 
options disponibles. L’icône dépend de l’option choisie. Sélectionnez la 
forme 3D choisie, puis tracez-la en cliquant sur la diapositive et en 
faisant glisser la souris pour dessiner le rectangle qui l’englobera. 
Pressez la touche Maj pour tracer une forme 3D de hauteur et largeur 
différentes (le comportement est inversé puisque par définition ces 
formes ont même largeur et hauteur). Pressez la touche Alt pour tracer 
une forme 3D depuis son centre.

En Courbe Convertit les objets sélectionnés en une courbe de Bézier. L’apparence 
de l’objet ne change pas. Vous pouvez voir les modifications en cliquant-
droit sur l’objet et en choisissant Éditer des points ou en cliquant sur 
l’icône Points de la barre d’outils Dessin.

En Polygone Convertit les objets sélectionnés en un polygone (un objet fermé bordé 
de lignes droites). L’apparence de l’objet ne change pas. Vous pouvez 
voir les modifications en cliquant-droit sur l’objet et en choisissant Éditer 
des points ou en cliquant sur l’icône Points de la barre d’outils Dessin.

En 3D Convertit les objets 2D sélectionnés en 3D.

En corps de 
révolution 3D

Convertit les objets 2D sélectionnés en corps de révolution 3D.

Insérer Insère une diapositive, un tableau et depuis un fichier, d’autres objets 
(image, vidéo, son, formules et diagrammes) dans votre présentation. 
Cliquez sur le triangle noir pour ouvrir une barre d’outils affichant les 
options disponibles. L’icône dépend de l’option choisie.

Contrôles Insère diverses formes de contrôles dans votre présentation. Cliquez sur 
le triangle noir pour ouvrir la barre d’outils Contrôles de formulaire 
affichant les options disponibles.

Image animée Ouvre la boîte de dialogue Animation pour ajouter un effet d’animation à
un objet sélectionné. L’objet est enregistré en différentes positions et en 
différents endroits, puis est visualisé en enchaînant ces différents 
enregistrements donnant ainsi une image animée. Voir Insérer des 
images animées page 36.
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Créer des courbes et des formes

Différencier des courbes et des formes
Dans LibreOffice, vous pouvez créer deux types d’objet 2D aux propriétés différentes :

• des  formes :  ces  objets  ont  des  propriétés  particulières  qui  vont  être  conservées
lorsqu’un changement de taille ou une rotation sera effectué ; par exemple un rectangle
aura toujours des angles droits, les étoiles auront des branches régulières, etc. ;

• des lignes, polygones ou courbes : la forme de l’objet est alors totalement libre et chaque
angle ou courbure est dessiné par l’utilisateur.

Pour distinguer une forme d’une courbe (ou polyligne ou polygone), les formes ont des poignées
de redimensionnement bleues, contrairement aux autres objets qui ont des poignées vertes.

Note
Il ne faut pas confondre les huit poignées bleues de redimensionnement entourant 
une forme, des poignées bleues correspondant aux angles des polygones et courbes
qui apparaissent lors de l’édition des points (F8).

Certaines formes disposent en plus de poignées jaunes, qui permettent de déformer une partie de
la forme (sourire de la frimousse, taille de la flèche, etc.).

Les formes peuvent être transformées en lignes, courbes ou polygones, et perdent alors leurs
propriétés et  leurs éventuelles poignées jaunes.  Cette transformation est irréversible :  vous ne
pouvez refaire une forme à partir d’une courbe.

Dans une courbe, chaque point peut être positionné indépendamment des autres, contrairement
aux formes où l’aspect prévu au départ est obligatoirement conservé.

Tracer des courbes et des formes
Pour créer des formes régulières et des lignes :

1) sélectionnez l’outil correspondant à votre besoin dans la barre d’outils Dessin ;

2) cliquez sur la diapositive, puis faites glisser pour créer l’objet.

Tracer des courbes
À l’aide d’une des options de l’outil Courbes de la barre d’outils Dessin, vous pouvez dessiner un
polygone à main levée (voyez Tableau 1 et Figure 2) :

Figure 2 : Options de l’outil Courbes

1) cliquez sur le triangle noir à côté de l’icône Courbes et choisissez un outil ;

2) cliquez  une  fois  sur  la  diapositive  et  déplacez  le  pointeur  pour  tracer  le  premier
segment ;

3) cliquez une fois à nouveau et tracez le segment suivant de votre polygone à main levée ;

4) pour terminer, double-cliquez lorsque vous avez tracé le dernier segment. Si vous avez
choisi un polygone fermé, Impress trace une ligne reliant le dernier point au premier et
remplit sa surface avec la couleur par défaut.

Si vous désirez que l’un des angles soit multiple de 45°, maintenez la touche Maj appuyée.

Pour tracer une courbe, cliquez et gardez appuyé le bouton gauche de la souris pour créer le point
de départ  de la  courbe.  Puis,  tout  en gardant  le bouton de la  souris appuyé,  faites glisser  le
curseur pour tracer une ligne droite à partir de ce point de départ. Relâchez le bouton gauche de la
souris et déplacez le curseur pour infléchir la ligne droite en une courbe. Cliquez pour fixer la
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courbe dans la page. Vous pouvez continuer votre ligne en déplaçant le curseur de la souris et en
cliquant pour fixer le point d’angle suivant ; vous pouvez infléchir la ligne obtenue en gardant le
bouton gauche de la souris appuyé et en le faisant glisser jusqu’à obtenir ce que vous désirez.
Pour terminer la courbe, double-cliquez.

Une courbe remplie joint automatiquement le dernier point de la courbe avec son point de départ,
pour la refermer et la remplir avec la couleur standard. Une courbe non remplie n’est pas refermée
à la fin du tracé.

Adapter les formes tracées
Lorsque vous dessinez certaines formes régulières, un ou plusieurs points jaunes sont affichés.
Leur action varie selon la forme que vous dessinez, comme expliqué ci-dessous.

Formes de base

• Carrés et  rectangles arrondis :  utilisez le  point  jaune pour faire varier  le  rayon de la
courbe qui remplace chaque angle.

• Secteur de cercle : utilisez le point jaune pour modifier la taille du secteur plein.

• Triangle isocèle : utilisez le point jaune pour changer le type du triangle.

Astuce

Pour dessiner un triangle équilatéral, dessinez un triangle isocèle dans des 
proportions proches de celle du triangle souhaité. Sélectionnez le menu Format > 
Position et taille. Décochez Proportionnel. Modifiez soit la hauteur, soit la largeur, 
soit les deux en respectant une proportion de 0,866 entre la hauteur et la largeur. 
Cochez Proportionnel pour conserver un triangle équilatéral si vous changez sa taille.

• Trapèze, parallélogramme, hexagone, ou octogone : utilisez le point jaune pour modifier
l’angle entre les côtés.

• Croix : utilisez le point jaune pour changer l’épaisseur des quatre bras de la croix.

• Anneau : utilisez le point jaune pour modifier le diamètre interne de la couronne.

• Arc plein : utilisez le point jaune pour modifier à la fois le diamètre interne et la taille du
secteur plein.

• Cylindre et cube : utilisez le point jaune pour changer la perspective.

• Coin replié : utilisez le point jaune pour modifier la taille de l’angle replié.

• Cadre : utilisez le point jaune pour modifier l’épaisseur du cadre.

Symboles

• Frimousse : utilisez le point jaune pour en modifier le sourire.

• Soleil, lune, cœur : utilisez le point jaune pour modifier la forme.

• Symbole “interdit” : utilisez le point jaune pour modifier l’épaisseur de l’anneau et de la
barre transversale.

• Parenthèses et double accolade : utilisez le point jaune pour changer la courbure de la
parenthèse.

• Accolades  gauche  et  droite :  utilisez  les  points  jaunes  pour  changer  la  courbure  de
l’accolade et la position de la pointe.

• Plaque carrée, octogonale, losange : utilisez le point jaune pour modifier l’épaisseur de
la plaque.

Flèches pleines

• Flèches : utilisez les points jaunes pour changer la forme et l’épaisseur des flèches.

• Pentagone, chevron : utilisez le point jaune pour modifier l’angle entre les côtés.
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• Légendes fléchées : utilisez les points jaunes pour changer la forme et l’épaisseur des
légendes.

• Flèche circulaire : utilisez les points jaunes pour modifier l’épaisseur et la longueur de la
flèche.

Légendes

• Légendes : utilisez les points jaunes pour modifier la longueur, la position et l’angle de la
pointe.

Étoiles

• Étoile à 4, 8 ou 24 branches : utilisez le point jaune pour modifier l’épaisseur et la forme
des branches.

• Parchemin vertical, horizontal : utilisez le point jaune pour modifier la largeur et la forme
du parchemin.

• Plaque de porte : utilisez le point jaune pour changer la courbure des coins.

Aide au tracé ou tracé libre
Pour le tracé des formes, celui-ci peut être modifié par combinaison des touches.

• Maj : par défaut cela force la hauteur et la largeur à être égales, ainsi un rectangle aura
la forme d’un carré s’il est dessiné avec la touche Maj enfoncée ; pour les formes devant
respecter  cette contrainte  (comme un carré ou un cercle),  l’appui  sur  la  touche  Maj
supprime cette contrainte, un carré donnera un rectangle s’il est tracé avec la touche
Maj enfoncée.

• Alt :  cette touche a  deux fonctions ;  d’une part  elle  permet  de dessiner  la  forme en
considérant le premier point comme le centre de la forme et non un coin de la forme ;
d’autre part, elle inverse l’option d’alignement ou non à la grille du second point (voir
‘Capturer des objets à la grille ou aux lignes de capture’ page 23).

• Ctrl : inverse l’option d’alignement ou non à la grille du premier point.

Pour le tracé des courbes ou lignes :

• Maj : l’angle de la ligne est forcé à un multiple de 45°.

• Alt : identique au comportement pour les formes.

• Ctrl : identique au comportement pour les formes.

Ce comportement est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de
la création ou du déplacement de l’objet de la section Enclencher de Outils > Options > LibreOffice
Impress > Grille est cochée, l’action de la touche Maj est inversée. Des carrés seront tracés, à
moins  que  la  touche  Maj  ne  soit  appuyée  pour  dessiner  des  rectangles.  Les  lignes  seront
automatiquement tracées avec un angle multiple de 45 degrés, à moins que la touche Maj ne soit
appuyée.

Le résultat dépend donc des options choisies pour la grille. Pour plus de détails sur l’utilisation de
la touche Ctrl, se référer au guide Draw chapitre 3 Manipuler les Objets et les Points des Objets.

Au cours de votre manipulation de la ligne (ou d’un autre élément), vous pouvez utiliser la zone
d’information de la barre d’état pour contrôler votre action. Le premier exemple de la Figure 3 vous
montre la zone d’information au cours du tracé d’une ligne. Le second exemple vous montre cette
même zone une fois la ligne tracée.
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Figure 3 : Zone d’information de la barre d’état

Grouper des objets

Il est quelquefois pratique de grouper des objets pour qu’ils soient traités par Impress comme un
seul objet. Un groupe d’objets peut être formaté comme un seul objet, déplacé, tourné, supprimé,
dupliqué, etc.

Pour regrouper des objets :

1) sélectionnez les  objets  à grouper :  pour  cela  utilisez  l’outil  Sélectionner de  la  barre
d’outils  Dessin,  cliquez au-dessus et à gauche de l’objet le plus haut à gauche, puis
glissez la souris jusqu’au-dessous et à droite de l’objet le plus bas à droite du groupe
sans relâcher le bouton appuyé ; un rectangle délimité par des poignées de sélection
apparaît  englobant les objets sélectionnés ;  vous pouvez aussi sélectionner plusieurs
objets en maintenant la touche Maj appuyée tout en sélectionnant individuellement les
objets ;

2) lorsque les poignées de sélection apparaissent, choisissez Format > Groupe > Grouper
dans le menu principal, ou pressez les touches Ctrl+Maj+G, ou encore cliquez-droit dans
le groupe et choisissez Grouper.

Pour éditer ou formater un groupe d’objets :

1) dès qu’un groupe est défini, cliquez sur l’un de ses objets pour sélectionner le groupe ;
toute commande d’édition  ou de formatage est  alors appliquée à tous les objets  du
groupe ;

2) pour éditer seulement un objet du groupe, pressez F3 lorsque le groupe est sélectionné,
ou choisissez Format > Groupe > Entrer dans le groupe dans le menu principal, ou
encore  cliquez-droit  et  choisissez  Entrer  dans le  groupe ;  vous pouvez maintenant
sélectionner individuellement les objets pour édition et formatage ;

3) pour sortir du traitement individuel, pressez Ctrl+F3 ou choisissez Format > Groupe >
Quitter le groupe dans le menu principal, ou encore cliquez-droit et choisissez Quitter
le groupe ; le groupe entier est maintenant sélectionné.
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Pour dégrouper les objets :

1) sélectionnez le groupe d’objets ;

2) lorsque  les  poignées  de  sélection  apparaissent,  choisissez  Format  >  Groupe>
Dissocier dans le menu principal, ou pressez  Ctrl+Alt+Maj+G, ou encore cliquez-droit
sur le groupe et choisissez  Dissocier ; attention, les poignées de sélection autour du
groupe restent visibles tant que vous n’avez pas cliqué en dehors de ces objets.

Pour en savoir plus sur la manière d’utiliser des objets groupés, voyez le guide Draw chapitre 5,
Combiner plusieurs objets.

Astuce

Si vous utilisez souvent les commandes de groupage, pourquoi ne pas les ajouter à 
l’une des barres d’outils affichées par défaut, elles seraient ainsi plus accessibles ? 
Pour cela, il vous faut personnaliser une barre d’outils, voyez le Chapitre 11, Installer 
et personnaliser Impress.

Déplacer des objets graphiques

Pour déplacer un objet graphique :

1) cliquez sur un objet graphique et les poignées de sélection apparaissent ;

2) déplacez le  pointeur  sur  l’objet  jusqu’à  ce que le  pointeur  change de forme :  sur  la
plupart  des  systèmes  d’exploitation,  le  pointeur  associé  au  déplacement  est  une
quadruple flèche, mais il peut aussi prendre la forme d’une main ;

3) cliquez et faites glisser l’objet graphique jusqu’à la position désirée ;

4) relâchez le bouton de la souris.

Vous  trouverez  également  des  informations  dans  la  barre  d’état.  La  zone  d’information  vous
indique que vous déplacez un objet et l’ampleur du déplacement. Les coordonnées indiquant la
position s’actualisent au cours du déplacement.

Astuce

Pour sélectionner un objet recouvert par un autre, maintenez la touche Alt appuyée 
et cliquez sur un endroit recouvert de l’objet. S’il y a plusieurs objets recouverts, 
chaque nouveau clic sélectionnera l’objet immédiatement derrière.
Cette méthode ne fonctionne pas sur les ordinateurs ayant Linux comme système 
d’exploitation.

Une fois l’objet sélectionné, vous pouvez aussi utiliser les touches Flèche du clavier :

• Flèche : déplace d’1 mm l’objet ;

• Maj+Flèche : déplace d’1 cm l’objet ;

• Alt+Flèche : déplace d’1 pixel l’objet ; le déplacement réel dépend donc du zoom.

Astuce

Par défaut, Impress accroche les objets à la grille. S’il faut placer l’objet entre deux 
points de la grille, cliquez sur l’objet et commencez à le déplacer, puis maintenez la 
touche Alt appuyée avant de relâcher au nouvel emplacement. Vous pouvez aussi 
désactiver l’accrochage à la grille (Affichage > Grille > Aligner sur la grille dans le 
menu principal), ou encore modifier sa résolution en choisissant Outils > Options > 
LibreOffice Impress > Grille dans le menu principal.
Si au contraire l’accrochage à la grille était désactivé, la touche Alt permet de le 
réactiver temporairement.
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Figure 4 : Boîte de dialogue Position et taille

Pour affiner le déplacement de l’objet  graphique, utilisez la boîte de dialogue  Position et taille
(Figure 4). Avec l’objet sélectionné et les poignées de sélection affichées, pressez la touche F4, ou
choisissez Format > Position et taille dans le menu principal, ou encore cliquez-droit sur l’objet
sélectionné et choisissez Position et taille dans le menu contextuel.

Utilisez la section  Position de la boîte de dialogue pour régler les positions horizontales (X) et
verticales (Y) de l’objet graphique. Les valeurs représentent la distance entre le point de base de
l’objet graphique choisi (partie droite de la boîte de dialogue) par rapport au coin en haut et à
gauche de la diapositive.

Pour prévenir une modification accidentelle de la position de l’objet, cochez la case Position dans
la section Protéger en bas à gauche de la boîte de dialogue.

L’unité de mesure pour cette boîte de dialogue est choisie avec le sous-menu Outils > Options >
LibreOffice Impress > général.

Redimensionner des objets graphiques

Pour redimensionner un objet graphique :

1) cliquez sur un objet graphique et les poignées de sélection apparaissent ;

2) déplacez le pointeur sur l’une des poignées de sélection : le pointeur change d’aspect,
représentant graphiquement la direction du redimensionnement ;

3) cliquez et faites glisser pour redimensionner l’objet graphique ;

4) relâchez le bouton de la souris pour terminer.

Les poignées d’angle redimensionnent simultanément la largeur et la hauteur de l’objet, alors que
les poignées latérales agissent sur une seule dimension.

Astuce
Pour conserver les proportions originales de l’objet graphique, maintenez la touche 
Maj appuyée juste avant de relâcher le bouton de la souris.
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Pour affiner le changement de taille de l’objet graphique, utilisez la boîte de dialogue Position et
taille (Figure 4) et procédez de la manière suivante :

1) sélectionnez l’objet graphique et ouvrez la boîte de dialogue Position et taille ;

2) sélectionnez comme point de base la partie de l’objet graphique que vous voulez ancrer
à la page ; la valeur par défaut signifie que la position du coin haut gauche ne change
pas pendant le redimensionnement ;

3) modifiez la Largeur ou la Hauteur de l’objet ;

4) pour conserver les proportions de l’objet graphique, cochez la case Proportionnel avant
toute  modification :  dans  ce  cas,  la  modification  de  l’une  des  dimensions  induira
automatiquement la modification proportionnelle de l’autre ;

5) pour éviter une modification intempestive de la taille de l’objet, cochez la case  Taille
dans la section Protéger en bas à gauche de la boîte de dialogue.

Affecter des effets spéciaux

Dans Impress, vous pouvez aussi ajouter des effets spéciaux aux objets graphiques. Plusieurs de
ces effets sont directement applicables depuis la barre d’outils Mode (Figure 5). Si la barre d’outils
Mode n’est pas affichée, choisissez Affichage > Barres d’outils > Mode.

Cette section décrit la manière de faire pivoter, retourner, déformer un objet ainsi que deux façons
de l’inscrire dans un cercle. Les outils Transparence et Dégradé relevant plutôt du formatage sont
traités dans le Chapitre 6, Mettre en forme des objets graphiques.

Figure 5 : Barre d’outils Mode

Faire pivoter des objets graphiques
La rotation d’un objet peut être exécutée manuellement ou à l’aide d’une boîte de dialogue, tout
comme  le  déplacement  et  le  redimensionnement.  Pour  faire  pivoter  manuellement  un  objet
graphique :

1) cliquez sur un objet graphique et les poignées de sélection apparaissent ;

2) cliquez  sur  l’icône  Tourner dans  la  barre  d’outils  Mode ou  de  la  barre  d’outils
Image ;

3) les poignées de sélection carrées deviennent des cercles ou ellipses rouges (Figure 6) ;

4) déplacez le pointeur de la souris sur une poignée d’angle, l’aspect du pointeur change ;

5) cliquez et déplacez le pointeur pour faire pivoter l’objet graphique ;

6) relâchez le bouton de la souris.
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Figure 6 : Objet sélectionné pour la rotation

Note
Sur votre machine, les icônes peuvent être différentes. En cas de doute, survolez 
l’icône avec la souris et attendez l’apparition de l’infobulle qui vous donnera son nom.

Vous  trouverez  également  des  informations  dans  la  barre  d’état.  La  zone  d’information  vous
indique que vous faites tourner un objet ainsi que l’angle de rotation. Les nombres indiquant la
position et la taille s’actualisent au cours de la rotation.

Lorsque l’outil  Rotation est  actif,  un petit  cercle apparaît  au centre de l’objet  sélectionné pour
indiquer le pivot. Dans la plupart des cas, un pivot central convient tout à fait, mais vous pouvez
avoir besoin de faire pivoter l’objet autour de l’un de ses angles ou même d’un point hors de
l’image. Pour déplacer le pivot, cliquez sur le cercle et faites-le glisser à l’emplacement désiré.

Pour forcer les angles de rotation à des multiples de 15 degrés, maintenez appuyée la touche Maj
pendant que vous faites pivoter l’objet. C’est très pratique pour obtenir un angle droit, par exemple
pour passer du format Portrait au format Paysage.

Plutôt que de faire pivoter manuellement un objet, vous pouvez utiliser l’onglet  Rotation de la
boîte de dialogue Position et taille (Figure 7). Pour l’afficher, sélectionnez l’objet et pressez F4, ou
choisissez Format > Position et taille dans le menu principal et sélectionnez l’onglet Rotation, ou
encore, cliquez-droit sur l’objet et choisissez Position et taille dans le menu déroulant.
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Figure 7 : Onglet rotation de la boîte de dialogue Position et taille

Dans la partie haute de la boîte de dialogue, sélectionnez la position du pivot par rapport au coin
haut gauche de la diapositive. La position par défaut est au centre de la figure.

Dans la partie basse de la boîte de dialogue, sélectionnez l’angle de rotation de l’objet. Dans la
partie droite, 8 angles prédéfinis peuvent être sélectionnés.

Astuce

Si vous devez régulièrement faire pivoter des objets, vous pouvez facilement activer 
cette commande en sélectionnant le mode Rotation après clic sur l’objet : affichez la 
barre d’outils Options (Affichage > Barre d’outils > Options) ; activez le premier 

bouton Mode Rotation après clic sur l’objet . Après avoir sélectionné un objet, il 
vous suffit de cliquer à nouveau dessus pour passer en mode rotation.

Retourner des objets
La  manière  la  plus  simple  et  la  plus  rapide  pour  retourner  un  objet  horizontalement  ou
verticalement est la suivante :

1) cliquez sur un objet graphique et les poignées de sélection apparaissent ;

2) cliquez-droit  et  choisissez  Refléter > Horizontalement ou  Refléter > Verticalement,
l’objet sera retourné.

L’outil Retourner de la barre d’outils Mode ou de la barre d’outils Image peut aussi être utilisé. Cet
outil vous permet en outre de déplacer l’axe de symétrie (Figure 8 :

1) cliquez sur un objet graphique et les poignées de sélection apparaissent ;

2) cliquez sur  l’icône Retourner  et  l’axe de symétrie  apparaît  comme une ligne de
pointillés traversant l’objet qui est alors entouré de poignées de sélection.
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Figure 8 : Utilisation de l’outil retourner

3) définissez la position de l’axe de symétrie :

– conserver l’orientation de l’axe : cliquez sur l’axe et faites-le glisser vers la position
désirée ;

– modifier l’orientation de l’axe : cliquez sur un des cercles à sa périphérie (pas son
centre) et faites-le glisser : l’axe pivote alors autour de son autre extrémité ;

4) déplacez le pointeur de la souris sur une des poignées de sélection : il change d’aspect ;

5) cliquez et faites glisser de l’autre côté de l’axe de symétrie : la future position de l’objet
est affichée en demi-teinte jusqu’à ce que le bouton de la souris soit relâché ;

6) relâchez le bouton de la souris et l’objet sera retourné ; l’angle et la position du résultat
dépendent de l’angle et de la position de l’axe de symétrie.

Note
Si vous maintenez la touche Maj appuyée pendant que vous faites pivoter l’axe de 
symétrie, son angle de rotation variera par paliers de 45 degrés.

Note
Si vous souhaitez retourner une forme (construite avec la barre d’outils Dessin), il est
préférable de la convertir en courbe avant de faire le retournement, car l’effet obtenu 
sur une forme ne sera pas forcément celui souhaité.

Copier en miroir
Actuellement il n’y a pas de commande miroir dans Draw ou Impress. Une copie en miroir peut
cependant être réalisée avec l’outil Retourner de la manière suivante :

1) sélectionnez l’objet dont vous voulez faire une copie en miroir (Figure 9) ;

Figure 9 : Créer une copie en miroir

2) copiez l’objet dans le presse-papier ;

3) sélectionnez l’outil Retourner dans la barre d’outils Mode ou la barre d’outils Image ;
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4) déplacez l’axe de symétrie vers l’emplacement voulu pour l’axe de la copie en miroir ;

5) retournez l’objet ;

6) cliquez dans une zone vide de la diapositive pour désélectionner l’objet ;

7) collez depuis le presse-papier pour replacer une copie de l’objet à son emplacement
initial et vous obtenez une copie en miroir.

Déformer un objet
Trois outils de la barre d’outils  Mode vous permettent de tirer les angles ou les côtés d’un objet
pour en déformer l’image. Les outils Déformer  et Positionner sur le cercle (en perspective)

 déforment un objet en perspective, et l’outil Positionner sur le cercle (incliner)  crée un
pseudo-effet tridimensionnel.

Lors du clic sur l’un de ces outils, si l’objet est une Forme (construite avec la barre d’outils Dessin),
Impress vous demande si elle doit être convertie en courbe de Bézier. Quelle que soit la réponse,
l’objet pourra être déformé, mais la déformation répondra probablement mieux à votre attente si
vous répondez  Oui. Le résultat de cette déformation variera en fonction de la nature de l’objet
(Forme, Polygone ou Courbe de Bézier). Les déformations présentées ici correspondent à des
formes converties en courbe ou à des courbes de Bézier.  Pour une information plus détaillée,
consultez le chapitre 3 Manipuler les objets et les points des objets du guide Draw.

Outil déformer

Sélectionnez un objet et cliquez sur l’icône  Déformer  sur la barre d’outils  Mode. Après une
éventuelle  conversion  en  une  courbe,  déplacer  les  poignées  pour  étirer  l’objet.  Les  poignées
d’angle déforment les coins, les poignées des côtés verticaux déforment horizontalement et les
poignées des côtés horizontaux déforment verticalement (Figure 10).

Figure 10 : Déformer une image

Outil positionner sur le cercle (en perspective)

Sélectionnez un objet et cliquez sur l’icône Positionner sur le cercle (en perspective)  dans
la  barre  d’outils  Mode.  Après  une  éventuelle  conversion  en  une  courbe  (si  la  conversion  est
refusée, la forme subira une simple rotation),  déplacez les poignées pour donner à l’objet une
forme en arc de cercle (Figure 11).
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Figure 11 : Placer une image dans un cercle avec perspective

Outil positionner sur le cercle (incliner)

Sélectionnez un objet et cliquez sur l’icône Positionner sur le cercle (incliner)  dans la barre
d’outils  Mode. Après une éventuelle conversion en une courbe (si la conversion est refusée, la
forme subira une simple translation), déplacez les poignées pour donner à l’objet une pseudo-
perspective tridimensionnelle inclinée (Figure 12).

Note
On ne peut revenir en arrière sur la transformation d’une forme en courbe qu’en 
cliquant sur le bouton Annuler ou avec la combinaison de touches Ctrl+Z.

Figure 12 : Placer une image dans un cercle avec inclinaison

Déplacer des formes

Aligner des formes
Utilisez les outils d’alignement pour régler la position relative d’un objet graphique par rapport à un
autre. Choisissez Affichage > Barre d’outils > Alignement dans le menu principal pour ouvrir la
barre d’outils  Alignement (Figure 13). Ces options d’alignement sont aussi disponibles lorsque
vous cliquez-droit sur un objet sélectionné.
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Figure 13 : La barre d'outils Aligner et ses options

La barre d’outils affiche six icônes. Les trois premières déterminent l’alignement horizontal des
objets sélectionnés (À gauche, Centré, À droite) ; les trois autres déterminent l’alignement vertical
des objets sélectionnés (En haut, Centre, En bas).

Si un seul objet est sélectionné, il est aligné sur la page. Si plusieurs objets sont sélectionnés en
même temps, ils sont alignés par rapport au groupe : pour les alignements gauche, droite, haut et
bas, l’alignement se fait par rapport au côté de l’objet le plus avancé dans cette direction ; pour les
alignements centrés, l’alignement se fait sur le centre du groupe d’objets sélectionnés.

Répartir des formes
Pour répartir de façon homogène des objets sur l’axe horizontal ou vertical :

1) sélectionnez les objets à répartir (ils doivent au moins être trois) soit par cliquer-glisser
pour entourer les objets concernés, soit par clics successifs en maintenant la touche Maj
enfoncée ;

2) cliquez-droit sur un des objets sélectionnés et choisissez Répartition.

Cette commande ouvre la  boîte de dialogue  Répartition (Figure 14).  Vous pouvez également
répartir de façon homogène l’espacement entre objets. Les objets sont répartis en fonction des
objets situés le plus vers l’extérieur dans la sélection.

La section Horizontal spécifie la répartition horizontale pour les objets sélectionnés.

• Aucune : ne modifie pas la répartition des objets horizontalement.

• À gauche : répartit les objets sélectionnés de telle sorte que leurs bords gauches sont
espacés régulièrement.

• Centre : répartit les objets sélectionnés de telle sorte que leurs centres horizontaux sont
espacés régulièrement.

• Espacement :  répartit  les  objets  sélectionnés  horizontalement,  en  forçant  les
espacements horizontaux entre les objets à être égaux.

• À droite :  répartit  les  objets  sélectionnés  de  telle  sorte  que  leurs  bords  droits  sont
espacés régulièrement.

La section Vertical spécifie la répartition verticale pour les objets sélectionnés.

• Aucune : ne modifie pas la répartition des objets verticalement.

• En haut : répartit les objets sélectionnés de telle sorte que leurs bords supérieurs sont
espacés régulièrement.

Gestion des objets graphiques 22



• Centre : répartit les objets sélectionnés de telle sorte que leurs centres verticaux sont
espacés régulièrement.

• Espacement : répartit les objets sélectionnés verticalement, en forçant les espacements
verticaux entre les objets à être égaux.

• En bas :  répartit  les objets sélectionnés de telle sorte que leurs bords inférieurs sont
espacés régulièrement.

Figure 14: Boîte de dialogue Répartition de formes

Note
Si les objets ont tous la même taille, la répartition sera identique quelles soient les 
options choisies.

Capturer des objets à la grille ou aux lignes de capture

Quelquefois,  il  est utile d’aligner des objets sur des points spécifiques de la diapositive ou de
s’assurer que des objets qui apparaissent sur plusieurs diapositives sont exactement au même
endroit. Pour cela, Impress propose deux mécanismes : Grille et Lignes de capture.

Utiliser la grille
Les  options  concernant  la  grille  sont  disponibles  en  cliquant-droit  sur  une  zone  vide  de  la
diapositive  en mode  Normal et  en  choisissant  Grille,  ou  en sélectionnant  Affichage > Grille
depuis le menu principal. Dans les deux cas, un sous-menu s’ouvre, proposant trois options.

• Afficher la grille : affiche la grille.

• Aligner sur la grille : les points d’ancrage d’un objet sont placés sur une grille lorsque
l’objet est créé, déplacé ou redimensionné. Le maintien enfoncé de la touche Alt permet
de  permuter  temporairement  cette  option  lors  d’un  déplacement  ou  d’un
redimensionnement.

• Grille au premier plan : affiche la grille par-dessus les objets.

Pour régler l’espacement de la grille et les options de capture, choisissez  Outils > Options >
LibreOffice Impress > Grille dans le menu principal.

Astuce
Si vous devez souvent modifier les options de la grille et des lignes de capture, vous 
pouvez afficher la barre d’outils Options (Affichage > Barre d’outils > Options) qui 
permet d’accéder facilement aux options d’affichage et d’ancrage à la grille.
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Utiliser les lignes de capture
Les options concernant les lignes de capture sont disponibles en cliquant-droit sur une zone vide
de la diapositive en mode  Normal en en choisissant  Lignes de capture,  ou en sélectionnant
Affichage > Lignes de capture depuis le menu principal.  Dans les deux cas,  un sous-menu
s’ouvre, proposant trois options.

• Afficher les lignes de capture : affiche les lignes de capture sur la diapositive.

• Capturer  aux  lignes de capture :  les  points  d’ancrage d’un  objet  s’accrochent  aux
lignes de capture lorsque l’objet est déplacé ou redimensionné.

• Lignes de capture au premier plan : affiche les lignes de capture sur le fond de page.

Figure 15 : Boîte de dialogue Nouvel objet de capture

Pour créer un nouveau guide :

1) cliquez-droit sur une zone vide de l’espace de travail et choisissez Insérer un point/une
ligne de capture dans le menu principal pour ouvrir la boîte de dialogue Nouvel objet de
capture (Figure 15) ;

2) choisissez le type d’objet de capture. Les champs actifs dépendent de ce choix : Point,
X et Y, Vertical X seul, Horizontal Y seul ;

3) saisissez la position de l’objet de capture ;

4) cliquez sur OK pour fermer la boîte de dialogue.

Astuce

Lorsque vous placez un objet de capture, il est utile d’afficher les règles, pour cela, 
choisissez Affichage > Règle dans le menu principal.
Créez une ligne de capture directement sur la diapositive en cliquant sur une règle et
en la faisant glisser sur la diapositive : règle du haut pour des lignes horizontales, 
règle de gauche pour des lignes verticales.

Pour éditer une ligne de capture :

1) cliquez-droit sur la ligne à éditer ;

2) choisissez Éditer la ligne de capture dans le menu contextuel ;

3) entrez une nouvelle valeur dans le champ X ou Y pour indiquer la position de la ligne et
cliquez sur OK.

Pour supprimer un objet de capture :

1) cliquez-droit sur la ligne à supprimer ;

2) choisissez Supprimer la ligne de capture dans le menu contextuel.
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Astuce
La barre d’outils Options (Affichage > Barre d’outils > Options) permet d’accéder 
facilement aux options d’affichage et de capture aux lignes de capture.

Disposer les objets

LibreOffice organise les objets en une pile  de telle  manière que les objets du haut  de la  pile
recouvrent ceux des niveaux inférieurs en cas de chevauchement. La position de chaque objet
dans la pile peut être modifiée en disposant les formes sur une diapositive.

Pour  changer le  niveau d’empilage,  sélectionnez un ou plusieurs objets et  cliquez sur le  petit
triangle noir à côté de l’icône Disposer  sur la barre d’outils Ligne et remplissage ou la barre
d’outils  Image pour  afficher  la  barre  d’outils  Position (Figure  16).  Les  options  de cette  barre
d’outils peuvent être aussi obtenues en cliquant-droit sur un objet sélectionné et en choisissant
Organiser.

Figure 16 : Barre d'outils position pour disposer les objets

Les quatre premiers outils déterminent la position dans la pile de l’objet sélectionné.

• Envoyer à l’avant : les objets sélectionnés sont placés devant tous les autres objets.

• Envoyer vers l’avant : les objets sélectionnés sont remontés d’un niveau dans la pile.

• Envoyer vers l’arrière : les objets sélectionnés sont descendus d’un niveau dans la pile.

• Envoyer à l’arrière : les objets sélectionnés sont placés derrière tous les autres objets.

Les trois autres outils déterminent les positions relatives des objets sélectionnés.

• Devant l’objet : place le premier objet sélectionné devant le second.

• Derrière l’objet : place le premier objet sélectionné derrière le second.

• Inverser : échange les positions respectives de deux objets sélectionnés dans la pile.

Pour utiliser les outils Devant l’objet et Derrière l’objet :

1) sélectionnez le premier objet en cliquant dessus ;

2) choisissez l’action Devant l’objet ou Derrière l’objet ;

3) le pointeur de la souris se transforme en une main à l’index pointé : cliquez sur le second
objet.
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Utiliser les connecteurs

Les connecteurs sont des lignes qui peuvent être ancrées à certains endroits, appelés points de
collage,  d’un  objet  graphique.  Lorsque  l’objet  connecté  est  déplacé  ou  redimensionné,  le
connecteur s’adapte automatiquement à la modification. Quand vous créez un organigramme, un
schéma ou un diagramme, il vaut mieux utiliser des connecteurs plutôt que de simples lignes.

Impress propose un échantillon de connecteurs prédéfinis qui diffèrent par leurs extrémités (flèche
ou non) ou leur tracé (ligne droite, segments ou courbe) comme sur la figure 17.

Figure 17 : Différents types de
connecteurs

Lorsqu’un  connecteur  est  tracé,  Impress  affiche  des  poignées  de  sélection  rouges  qui
n’apparaissent pas sur des lignes ordinaires. Ces poignées peuvent être utilisées pour modifier le
cheminement du connecteur.

Tracez un connecteur de la même manière qu’un objet quelconque :

1) ouvrez d’abord la barre d’outils  Connecteurs (Figure 17) en cliquant-droit sur le petit
triangle noir à côté de l’icône Connecteur  de la barre d’outils Dessin (le connecteur
affiché dépend du choix précédent) ;

2) sélectionnez dans la barre d’outil le type de connecteur à utiliser ;

3) déplacez le pointeur sur l’un des objets à connecter, de petites croix apparaissent autour
des bords de l’objet. Ce sont les points de collage où un connecteur peut être attaché ;

4) cliquez  sur  le  point  de  collage  qui  vous  convient  pour  attacher  une  extrémité  du
connecteur, maintenez appuyé le bouton de la souris et faites glisser le connecteur vers
un autre objet ;

5) lorsque le pointeur passe au-dessus d’un point de collage de l’objet visé, relâchez le
bouton de la souris : le connecteur est alors dessiné ;

6) si des poignées carrées sont affichées sur le connecteur, son cheminement peut être
modifié afin qu’il ne passe pas au-dessus d’autres objets.

Pour apprendre à formater un connecteur, référez-vous à la section “Formater des connecteurs” du
Chapitre 6, Mettre en forme des objets graphiques.

Gestion des points de collage
Un  point  de  collage  est  le  point  d’attachement  d’un  connecteur  sur  une  forme  ou  un  objet
graphique. Chaque forme possède un nombre prédéfini de points de collage, mais il est possible
de les modifier ou d’en ajouter à l’aide de la barre d’outils Points de collage. Cliquez sur l’icône
Points de collage  sur  la  barre d’outils  Dessin,  ou  choisissez  Affichage > Barres d’outils  >
Points de collage dans le menu principal pour ouvrir la barre d’outils Points de collage (Figure
18).

Le premier outil insère un nouveau point de collage sur un objet. Les quatre suivants déterminent
la direction de sortie du connecteur se terminant au point de collage.

Pour conserver la position relative d’un point de collage lorsque vous redimensionnez un objet,
assurez-vous que l’icône  Point de collage relatif est sélectionnée. Désactiver l’icône  Point de
collage relatif active les six outils restants sur la barre d’outils. Utilisez ces icônes pour fixer la
position  d’un  point  de  collage  pendant  le  redimensionnement  d’un  objet.  Vous  ne  pouvez
désactiver l’icône Point de collage relatif qu’après avoir inséré le point.
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Pour effacer un point de collage personnalisé, sélectionnez-le et appuyez sur la touche Suppr.

Figure 18 : La barre d'outils Points de collage et ses
options

Pouvoir  définir  de  nouveaux  points  de  collage  est  particulièrement  utile  lorsque  plusieurs
connecteurs arrivent sur le même côté d’une forme ou lorsque la position du point prédéfini ne
vous convient pas.

Pour déplacer un point de collage prédéfini ou nouvellement créé :

1) sélectionnez l’outil Points de collage sur la barre d’outils Dessin ;

2) sélectionnez  l’objet,  et  déplacez  le  pointeur  de  la  souris  sur  le  point  à  déplacer ;
lorsqu’un petit carré apparaît à côté du pointeur, cliquez dessus ;

3) maintenez appuyé le bouton de la souris, et faites glisser le point jusqu’à l’emplacement
choisi et relâchez le bouton.

Astuce

Par défaut les objets étant alignés sur la grille, les nouveaux points de collage seront 
aussi placés sur la grille (voyez Capturer des objets à la grille ou aux lignes de 
capture, page 23). Il peut cependant être utile d’affiner leur position en fonction de la 
forme de l’objet. Pour cela, désélectionnez Affichage > Grille > Aligner sur la grille 
avant de déplacer le point de collage, ou maintenez la touche Alt enfoncée lors du 
déplacement.
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Travailler avec des formes 3D

Avec Impress, vous pouvez créer des objets graphiques de plusieurs manières.

• Avec la barre d’outils  Objets 3D : si l’outil  Objets 3D  n’apparaît pas sur la barre
d’outils Dessin, cliquez-droit dans sa rangée d’icônes, choisissez Boutons visibles, puis
sélectionnez  Objets 3D dans la liste. Sur la barre d’outils  Dessin,  cliquez sur le petit
triangle noir à côté de l’icône Objets 3D pour afficher la barre d’outils Objets 3D (Figure
19). Ces objets sont considérés comme des séquences 3D et non comme des formes.

Figure 19 : Outils Objets 3D

• Avec le sous-menu Convertir : cliquez-droit sur une forme sélectionnée. Dans le sous-
menu Convertir, choisissez soit En 3D pour extruder (donner de l’épaisseur à un objet),
soit  En corps de révolution 3D pour obtenir une séquence 3D résultant de la rotation
de l’objet autour d’un axe. La forme convertie en 3D perd ses propriétés de forme et
devient une séquence 3D.

• Avec l’icône  (Dés)activer l’extrusion  de la barre d’outils  Dessin :  sélectionnez la
forme à modifier, puis cliquez sur l’icône  (Dés)activer l’extrusion de la barre d’outils
Dessin pour afficher la barre d’outils  Paramètres 3D (Figure 20). En même temps, la
forme  prend  de  l’épaisseur  et  devient  une  forme  3D.  Cette  méthode  n’est  possible
qu’avec des formes construites avec la barre d’outils Dessin. Elle ne fonctionne pas avec
les courbes et les formes converties en courbes.

Figure 20 : Outils paramètres 3D

Tableau 3 : Paramètres 3D et leur fonction

Outil Nom Effets

(Dés)activer 
l’extrusion

Ajoute de l’épaisseur à une forme et ouvre la barre d’outils 
Paramètres 3D. Permet également d’annuler cette transformation et 
de revenir à la forme d’origine.

Incliner vers le 
bas

Incline l’objet vers le bas d’un angle de 5 degrés autour d’un axe 
horizontal.

Incliner vers le 
haut

Incline l’objet vers le haut d’un angle de 5 degrés autour d’un axe 
horizontal.

Incliner vers la 
gauche

Incline l’objet vers la gauche d’un angle de 5 degrés autour d’un axe 
vertical.

Incliner vers la 
Droite

Incline l’objet vers la droite d’un angle de 5 degrés autour d’un axe 
vertical.

Profondeur Détermine l’épaisseur de la forme. Une palette de la barre d’outils 
propose quelques valeurs par défaut. Si aucune ne vous convient, 
sélectionnez Personnalisé… et saisissez l’épaisseur désirée.

Direction Ouvre une extension de la barre d’outils qui vous permet de choisir la 
direction et le type (parallèle ou perspective).

Éclairage Ouvre une extension de la barre d’outils qui vous permet de choisir la 
direction et l’intensité de la lumière.
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Outil Nom Effets

Surface Donne le choix entre Fil de fer (pratique pour manipuler l’objet), Mat, 
Plastique ou Métal.

Couleur 3D Permet de choisir la couleur de l’épaisseur de l’objet.

Note

Les formes converties en 3D (séquences 3D) perdent leur propriété de forme : les 
poignées deviennent vertes et les poignées jaunes disparaissent.
Les formes dont l’extrusion a été activée (formes 3D) restent des formes : les 
poignées jaunes sont toujours opérationnelles et la transformation est réversible en 
désactivant l’extrusion.

Bien  qu’Impress  offre  des  fonctions  évoluées  pour  manipuler  les  objets  3D,  ce  guide  décrit
seulement  les  paramètres  applicables  à  une  forme  avec  l’extrusion  activée.  Pour  plus
d’informations sur l’utilisation des effets 3D évolués tels que la géométrie et l’ombrage, référez-
vous au chapitre 7 du guide Draw (Manipuler les objets 3D).

Utilisez les outils de la barre Paramètres 3D listés dans le Tableau 3 pour modifier l’aspect d’une
forme 3D. Un exemple de forme extrudée en 3D est montré sur la Figure 21.

Figure 21 : Exemple de forme extrudée en 3D

La plupart des formes Fontwork (voir “Utiliser Fontwork”, page 31) possèdent des propriétés 3D et
peuvent donc être manipulées avec la barre d’outils Paramètres 3D.

Astuce
Sur le wiki, vous trouverez un tutoriel très détaillé pour créer des objets 3D 
sophistiqués : https://wiki.documentfoundation.org/FR/Draw/Tutoriel
À lire juste pour le plaisir des yeux !

Convertir un objet d’un type à un autre

Vous  pouvez convertir  un  objet  en différents  types.  Cliquez-droit  sur  un objet  et  sélectionnez
Convertir pour afficher un sous-menu contenant les options suivantes.

• En courbe : convertis l’objet sélectionné en courbe de Bézier ; cliquez sur l’icône Points

 de la barre d’outils Dessin pour éditer les points après conversion en courbe, vous
pouvez alors cliquer et tirer sur les points pour déformer l’objet.

• En polygone : convertit l’objet sélectionné en polygone ; cliquez sur l’icône Points de la
barre d’outils Dessin pour éditer l’objet après conversion en polygone ; un polygone est
toujours constitué de segments droits.
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• En contour :  pour des formes de base c’est  l’équivalent de  En polygone,  pour des
formes plus complexes (ou des objets texte) ce type de conversion crée un groupe de
polygones que vous pouvez manipuler.

• En 3D : convertit l’objet sélectionné en un objet 3D par une extrusion.

• En corps de révolution 3D : crée une forme tridimensionnelle en faisant tourner l’objet
sélectionné autour d’un axe vertical.

• En bitmap : convertit l’objet sélectionné en bitmap.

• En  Méta-fichier :  convertit  l’objet  sélectionné  au  format  WMF  (Windows  Metafile
Format), contenant à la fois, bitmap et données graphiques vectorielles.

Note
Dans de nombreux cas, la conversion ne produit pas immédiatement des résultats 
visibles.

Astuce
En courbe, En polygone, En 3D, et En corps de révolution 3D peuvent être 
ajoutés à la barre d’outils Dessin en tant qu’outils additionnels en cliquant sur la barre
et en choisissant Boutons visibles.

Attention Si vous convertissez une forme construite avec la barre d’outils Dessin, elle perdra 
alors ses propriétés de forme : les poignées jaunes ne seront plus disponibles, la 
conversion en 3D ne sera pas réversible. Seul le bouton (Dés)activer l’extrusion 
permet de conserver les propriétés de la forme.

Paramétrer l’interaction avec un objet

Vous pouvez associer une action avec un objet. Cette action est réalisée lorsque l’utilisateur clique
sur l’objet. Pour créer une interaction :

1) sélectionnez l’objet auquel vous voulez associer une action ;

2) cliquez sur l’icône Interaction  de la barre d’outils Ligne et remplissage, ou cliquez-
droit sur l’objet et choisissez Interaction dans le menu contextuel, la boîte de dialogue
Interaction s’ouvre (Figure 22) ;

3) sélectionnez le type d’interaction avec ses paramètres s’il en a ;

4) cliquez sur OK pour fermer la boîte de dialogue.

Les  interactions  sont  décrites  dans le  Tableau 4 et  la  boîte  de dialogue change d’aspect  en
fonction du type choisi.

Pour ôter une interaction d’un objet graphique, reprenez les étapes 1 et 2 ci-dessus et choisissez
le type Aucune action dans l’étape 3.
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Figure 22 : Boîte de dialogue Interaction

Tableau 4 : Types d’interaction et leurs paramètres

Interaction Paramètres

Aller à la diapositive 
précédente

Aucun paramètre.

Aller à la diapositive 
suivante

Aucun paramètre.

Aller à la première 
diapositive

Aucun paramètre.

Aller à la dernière 
diapositive

Aucun paramètre.

Aller à la page ou 
l’objet

Choisissez la cible dans la boîte qui s’ouvre.

Aller au document Cliquez sur le bouton Parcourir pour ouvrir une fenêtre standard de 
navigateur de fichier qui vous permettra de rechercher le document.

Jouer un son Sélectionnez le fichier contenant le son à jouer. Cliquez sur le bouton 
Parcourir pour ouvrir une fenêtre standard de navigateur de fichier.

Exécuter le 
programme

Sélectionnez le programme à exécuter. Cliquez sur le bouton Parcourir 
pour ouvrir une fenêtre standard de navigateur de fichier.

Exécuter la macro Sélectionnez une macro qui s’exécutera pendant la présentation. Cliquez 
sur le bouton Parcourir pour ouvrir la boîte de dialogue du sélecteur de 
macros.

Quitter la 
présentation

Lorsque vous cliquerez sur cet objet, la présentation se terminera.

Utiliser Fontwork

Utilisez Fontwork pour obtenir des effets de texte spéciaux. Pour plus d’informations sur le sujet,
consultez le chapitre 11, Images, Gallery et Fontwork du guide Débuter avec LibreOffice.
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Figure 23 : Galerie Fontwork

Pour débuter avec Fontwork :

1) ouvrez la galerie Fontwork (Figure 23), en cliquant sur l’icône Galerie Fontwork  sur
la barre d’outils  Dessin ou la barre d’outils  Fontwork (Figure 24) ;  si  la barre d’outils
Dessin n’est pas affichée, vous pouvez afficher directement la barre d’outils Fontwork en
choisissant Affichage > Barres d’outils > Fontwork dans le menu principal ;

2) sélectionnez votre style préféré dans la galerie Fontwork (Figure 23) et cliquez sur OK :
le mot Fontwork dans le style choisi s’inscrit alors sur la diapositive et à ce moment, vous
pouvez modifier sa forme et ses propriétés ;

3) double-cliquez sur l’objet ou appuyez sur F2 pour éditer le mot Fontwork ; saisissez votre
propre texte pour remplacer le mot Fontwork ;

4) pressez la  touche  Échap ou  cliquez hors de la  zone délimitée par  les  poignées de
redimensionnement pour quitter le mode édition ;

5) vous pouvez éditer quelques-uns de ses attributs à l’aide de la barre d’outils Fontwork ou
des autres outils servant à modifier les propriétés des objets.

Utiliser la barre d’outils Fontwork
Assurez-vous que la barre d’outils Fontwork (Figure 24) est affichée sur l’espace de travail. Sinon,
choisissez Affichage > Barres d’outils > Fontwork dans le menu principal.

Avec l’outil Galerie Fontwork, cette barre d’outils contient les outils suivants.

• Forme Fontwork  : permet de changer la forme de l’objet sélectionné ; les formes
sont  choisies  dans  la  barre  d’outils  (Figure  25)  qui  s’ouvre  lorsque  cet  outil  est
sélectionné.

Figure 24 : Barre d'outils Fontwork
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Figure 25 : Barre d'outils Formes de Fontwork

• Hauteur identique pour les lettres Fontwork  : change la hauteur des lettres dans
l’objet sélectionné ; Cet outil bascule la hauteur des lettres entre deux états.

• Alignement Fontwork  : aligne le texte dans son cadre en fonction de votre choix
(Aligner à gauche, Centrer, Aligner à droite, Mots justifiés, Étirement justifié).

• Espacement  des  caractères  Fontwork  :  permet  de  sélectionner  l’espacement
entre les caractères et d’indiquer l’utilisation des paires de crénage (voir le  Chapitre 3,
Ajouter et mettre en forme du texte, au paragraphe Formater des caractères.) ; pour un
espacement  personnalisé,  saisissez  une  valeur  en  pourcentage :  100 %  étant
l’espacement normal, inférieur à 100 %, resserre les caractères (espacement condensé),
supérieur à 100 %, écarte les caractères (espacement étendu).

Modifier un texte Fontwork comme une forme
Un texte Fontwork est une forme et il est possible de lui appliquer tous les formatages qui ont été
décrits dans ce chapitre, au même titre que les formes construites avec la barre d’outils Dessin.

Astuce
Vous pouvez changer la couleur d’un texte Fontwork rapidement en utilisant la zone 
Remplissage couleur de la barre d’outils Ligne et remplissage.

Vous pouvez modifier quelques formes Fontwork comme vous modifiez les angles des formes de
base  trapèze  et  parallélogramme  en  déplaçant  le  point  affiché  avec  les  poignées  de
redimensionnement jaunes.

Animations

Des  transitions  animées  peuvent  être  ajoutées  entre  les  diapositives  pour  donner  à  votre
présentation  un  aspect  plus  professionnel  lors  du  passage  à  la  diapositive  suivante  (voir  le
Chapitre 9, Diaporamas. Transitions, animations, et plus encore pour plus d’informations sur les
transitions). Cependant, Impress vous permet aussi d’ajouter des animations sur les diapositives
elles-mêmes pour donner plus d’intérêt à votre présentation.

Une  animation  consiste  en  une  séquence  d’images  ou  d’objets,  nommés  cadres,  affichés
successivement. Chaque cadre peut contenir un ou plusieurs objets. Par exemple, faire apparaître
les listes à puce ligne par ligne. Les animations peuvent être contrôlées par le clavier, le clic de
souris ou par une séquence temporisée.

Il y a deux moyens de créer une animation avec Impress : Animation personnalisée (page 34) ou
Insertion >  Image animée (page  36).  Les deux donnent  des résultats  très  différents  et  sont
décrits ci-dessous.

Astuce
Des animations peuvent donner un bel effet à une présentation, mais il ne faut pas 
en abuser sous peine d’alourdir les enchaînements et diminuer ainsi l’attention de 
l’auditoire.
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Animation personnalisée
Cette section contient les éléments suivants.

• Ajouter : ouvre la boîte de dialogue Animation personnalisée (Figure 27) pour ajouter un
effet d’animation à un objet sélectionné sur la diapositive.

• Modifier :  ouvre  la  boîte  de  dialogue  Animation  personnalisée pour  modifier  l’effet
d’animation d’un objet sélectionné sur la diapositive.

• Supprimer : ôte l’effet d’animation sélectionné.

• Début :  affiche  la  propriété  de  démarrage  de  l’effet  d’animation  sélectionné.  Les
propriétés de démarrage suivantes sont disponibles.

• Au clic : l’animation démarre lors d’un clic de souris.

• Avec le précédent : l’animation démarre en même temps que la précédente animation
ou immédiatement s’il n’y en avait pas.

• Après le précédent : l’animation démarre dès la fin de la précédente animation.

• Propriétés :  sélectionne des propriétés supplémentaires pour une animation :  cliquez
sur  le  bouton  … pour  ouvrir  la  boîte de dialogue  Options d’effet (Figure  28),  avec
laquelle vous pouvez sélectionner, régler et appliquer des propriétés à l’effet choisi.

Note
Le nom de cette option change selon le type de l’effet choisi, par exemple, Propriété,
Première couleur, Direction, etc., les options proposées changent aussi.

Figure 26 : Section animation personnalisée                 Figure 27 : Boîte de dialogue Animation
personnalisée
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Figure 28 : Boîte de dialogue Options d'effets

• Vitesse : indique la vitesse ou la durée de l’effet choisi.

• Modifier l’ordre : cliquez sur l’un de ces boutons pour déplacer l’animation sélectionnée
vers le haut ou vers le bas dans l’ordre des animations.

• Lire : joue un aperçu de l’effet d’animation.

• Diaporama : lance le diaporama à partir de la diapositive sélectionnée.

• Aperçu automatique :  si coché, donne un aperçu de tout ajout ou modification d’un
effet dès qu’il est sélectionné.

• La  boîte  de  dialogue  Animation  personnalisée  (Figure  27)  ouverte  par  les  actions
Ajouter et  Modifier décrites ci-dessus contient dans différents onglets les catégories
d’effets suivantes.

• Onglet Entrée : comment un objet apparaît sur la diapositive.

• Onglet Accentuation : comment l’objet est mis en évidence lors de son affichage.

• Onglet Quitter : comment un objet disparaît de la diapositive.

• Onglet Trajectoire : comment l’objet se déplace durant l’animation.

• Onglet Effets divers : comment se comporte le média pendant l’animation.

• Liste déroulante Vitesse : indique la vitesse ou la durée à donner à l’effet sélectionné.

• Aperçu automatique :  si coché, donne un aperçu de tout ajout ou modification d’un
effet dès qu’il est sélectionné.

Créer une animation avec l’animation personnalisée
Voici la démarche pour créer un ou plusieurs objets animés avec Animation personnalisée :

1) ouvrez la section Animation personnalisée (Figure 26), en cliquant sur son nom dans le
volet  Tâches ;  on  peut  aussi  l’ouvrir  en  choisissant  Diaporama  >  Animation
personnalisée dans  le  menu  principal  ou  en  cliquant  sur  l’icône  Animation
personnalisée dans la barre d’outils Ligne et remplissage ou la barre d’outils Image ;

Note
L’outil Animation personnalisée  est un outil additionnel à la barre d’outils 1) 
Ligne et remplissage. Il peut y être ajouté en cliquant-droit dans sa rangée d’icônes 
et en choisissant Boutons visibles, puis en la sélectionnant.

2) sélectionnez un objet sur la diapositive ;
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3) cliquez  sur  Ajouter dans  la  section  Animation  personnalisée pour  ouvrir  la  boîte  de
dialogue Animation personnalisée (Figure 27) ;

4) sélectionnez une catégorie d’effets et le type d’effet que vous voulez appliquer à l’objet
sélectionné ;

5) sélectionnez la vitesse de l’effet (si disponible) dans la liste déroulante et cliquez sur le
bouton OK ;

6) sélectionner la façon dont va commencer l’effet dans la liste déroulante Début ;

7) choisissez éventuellement une option dans la liste déroulante qui suit : son nom varie en
fonction de l’effet (Propriétés, Direction, Couleur de ligne…) ;

8) cliquez éventuellement sur le bouton … pour ouvrir la boîte de dialogue Options d’effet
(Figure 28) pour déclarer les paramètres de l’effet, puis cliquez sur OK ; cette boîte de
dialogue diffère selon l’objet sélectionné (si c’est un texte ou une forme) et l’effet qui lui
est appliqué ;

9) si nécessaire, modifiez l’ordre d’apparition des objets au cours de l’animation en cliquant
sur les flèches Modifier l’ordre ;

10) vous pouvez cliquer sur Lire pour contrôler l’effet de l’animation ;

11) lorsque vous avez obtenu l’effet que vous attendiez, cliquez sur le bouton  Diaporama
pour dérouler votre présentation.

Insérer des images animées
Vous pouvez créer  une image animée,  puis  l’insérer  dans votre présentation en sélectionnant
Insertion > Image animée dans le menu principal ou en cliquant sur l’icône Image animée
sur la barre d’outils Dessin (cf. le paragraphe Outils de dessin supplémentaires si l’icône n’est pas
visible), ce qui ouvre la boîte de dialogue Animation (Figure 29). Les contrôles d’animation sont
décrits dans le Tableau 5.

Figure 29 : Boîte de dialogue Animation
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Tableau 5 : Contrôles de la boîte de dialogue Animation

Contrôle Nom du Contrôle Effets

Première image Saute à la première image dans la séquence d’animation.

Précédent Lit l’animation en arrière.

Arrêter Arrête la lecture de l’animation.

Lire Lit l’animation.

Dernière image Saute à la dernière image dans la séquence d’animation.

Numéro de l’image Indique la position de l’image courante dans la séquence 
d’animation. Si vous voulez voir une autre image, saisissez 
son numéro ou cliquez sur les flèches haut et bas.

Durée de l’affichage Saisissez la durée d’affichage de l’image (en secondes). 
Cette option est aussi disponible si vous avez choisi Objet 
bitmap ou Objet de groupe.

Nombre de cycles Indique le nombre de lectures de l’animation. Pour une 
lecture continue, choisissez Max.

Appliquer l’objet Applique l’objet sélectionné comme une seule image.

Appliquer les objets
un par un

Ajoute une image pour chaque objet sélectionné. Si vous 
sélectionnez un groupe d’objets, une image est créée pour 
chaque objet du groupe.
Vous pouvez aussi sélectionner une animation, telle qu’un 
fichier animé GIF, et cliquer sur cette icône pour l’éditer. 
Lorsque vous avez terminé l’édition, cliquez sur Créer pour 
insérer une nouvelle animation dans votre diapositive.

Supprimer l’image 
active

Supprime l’image courante de la séquence d’animation.

Supprimer toutes 
les images

Supprime toutes les images de la séquence d’animation.

Nombre Nombre d’images dans la séquence d’animation.

Objet de groupe Rassemble les images en un seul objet pour qu’il puisse 
être manipulé comme un groupe. Vous pouvez toujours 
éditer chaque objet individuellement en double-cliquant sur 
le groupe dans la diapositive.

Objet Bitmap Combine les images en une seule image.

Créer Insère l’animation dans la diapositive active.
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Créer une animation avec la boîte de dialogue image animée
Pour créer une animation (succession d’images simulant un film) sélectionnez Insertion > Image
animée dans le menu principal, puis :

1) sélectionnez  un  objet  et  cliquez  sur  l’icône  Appliquer  l’objet  pour  le  placer  en
premier élément de l’animation ;

2) appliquez une transformation à l’objet ; par exemple, rotation, changement de couleur,
ajout ou suppression de caractères, etc. ;

3) sélectionnez le nouvel élément de l’animation, et cliquez l’icône  Appliquer l’objet une
nouvelle fois pour ajouter un nouvel élément ;

4) répétez les étapes 2 à 4 tant que vous avez des éléments à ajouter à l’animation ;

5) cochez  Objet bitmap pour personnaliser la durée de chaque image et le nombre de
répétitions de l’animation ;

6) cliquez sur le bouton Créer et l’Image animée est placée sur la diapositive.

Note
Si l’image à copier dans l’Animateur est composée de plusieurs objets, vous pouvez 
traiter chaque objet comme un élément séparé en cliquant sur l’icône Appliquer les 

objets un par un , chaque objet sera centré dans l’animation

Astuce

Pour créer rapidement une animation présentant la rotation d’un objet sur lui-même, 
commencez par dupliquer l’objet (Maj+F3) en (N-1) copies, chacune décalée d’un 
angle α, tel que N x α = 360°. Sélectionnez toutes les copies et ouvrez la boîte de 
dialogue Image animée. Cliquez sur le bouton Appliquer les objets un par un puis 
sélectionnez Objet bitmap. Enfin cliquez sur Créer : ça tourne !
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